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1 Introduction 

This integration guide details the processes required to integrate the Apteco Marketing 

Suite with the MAPP email service provider (ESP). 

Integr21Bation options: 

FastStats 
For a one-off broadcast, you can use a combination of the Email Broadcasting and Email 

Responses wizards to upload your list, schedule a broadcast campaign, and finally 

receive responses from your customers back into your FastStats system for furt22Bher 

analysis. 

PeopleStage 
Automate data uploads for unattended and scheduled marketing broadcasts, 

PeopleStage will allow you to define and implement marketing process flow diagrams 

that will react to the responses you receive from the ESP. 

Export and Upload a File 
Note: 

Apteco approves this integration with MAPP.  Use of the Apteco Marketing Suite in 

combination with MAPP software through this integration will not affect the 

intellectual property rights indemnity provided in the Apteco Marketing Suite “End 

User Licenc5Be Agreement”. 

 

 Summary of MAPP Functionality 
Technology 
MAPP integrates with your FastStats system by utilising SOAP trans 25Bport over HTTP/S. 

Supported Integrations 
MAPP supports all the above integration options. 

Note: 

At the time of writing this guide Teradata was the name used in the Apteco Marketing 

Suite. Select Teradata from the Response Gatherer, FastStats Plugin Configurations > 

Edit Template, and the PeopleStage Channel Editor 

Type of Integration - Predefined 
MAPP is a Predefined integration meaning the output is defined by an administrator 

and will be structured to match the required field layout of the Digital Integrator's 

subscriber database. Typically, this type of list will contain standard and 6Btransactional 

data. 

Response Queue 
Introduced in Q1 2020 

This integration supports the Response Queue option for collecting responses. 
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 Before You Begin 
CAUTION 

This guide assumes you have the relevant Apteco Marketing Suite system 

administration experience to perform this task, particularly with the FastStats 

Administrator, SQL Server and the areas of the Apteco Marketing Suite that relate to 

creating selections and campaign creation. If you do not, contact your Apteco partner 

or the Apteco support team. You need to have the appropriate system and SQL Server 

administrator permissions to install the relevant components successfully. Additionally, 

you will need to have access to the broadcaster web-based control panel and obtain all 

the relevant information from MAPP. You will also need to understand how to 

construct your message in MAPP. 

You need to configure MAPP before you perform the steps in Chapter 4 

The 

Useful to have before you start: 

• Database Connection String made up of the database server Instance name 

and FastStats system name, for example: 

• <SQLServerInstanceName>;Initial Catalog=RS_<SystemName>;User 
Id=<username>;Password=<password>; 

• The Digital Integration.zip available from: 

https://www.apteco.com/portal/software-releases 

• Decide where your FERG folders are to be created 

Used to store the .xml and .bat files used when scheduling FERG 

Bulk insert folder must be accessible from SQL Server to use BULK INSERT 

• Decide where you want the FastStats Email Response Gatherer to be installed 

This will typically be on the same PC as the FERG folders but can be on any PC 

• If you are using the response queue, you need to specify a v13 or higher URL e.g. 
URL=https://cook.shortest-route.com/apteco-demo/api/rest/v13 

Important: 

You must configure the MAPP system, *see appendix A 

• The Username and Password for your MAPP Control Panel and the API Username 

and Password 

• The MAPP *Message and *List (Group) name 

• The Import Automatic ID (Id from your *Process Control XML Automation) 

• Your own FTP folder with username and password 

• Create a directory in the root of your ftp site called XmlJob for the Apteco 

Marketing Suite upload the Mapp Package files that control the audience 

Note: 

All communication is done over a secure channel so acce7Bss over port 443 is required 

 

 

https://www.apteco.com/portal/software-releases
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2 Process Summary 

 Architecture 
The following diagrams describe a typical process from FastStats to MAPP, to the 

customer and back to FastStats. 

Schematic showing campaign scheduling performed in MAPP. 

 

1. A broadcast is initialised through the FastStats Web Service using FastStats or 

PeopleStage, which inserts a job into the Web Service Control database (WS_DB). 

2. The FastStats Service picks this job up, uploads the list to MAPP via SOAP 

communication. 

Note: 

Step 2 You need an FTP account to upload to  MAPP. 

3. MAPP then imports the contents of this list to its subscribers and associates them 

with a list name ready for use in any email campaigns. 

4. A campaign can then be scheduled using the MAPP web interface. 

5. MAPP sends Messages to all recipients on the list. 

6. MAPP records any undelivered messages. 
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7. MAPP records a response for each interaction with a message (for example opens 

and clicks). 

8. The FastStats Email Response Gatherer (FERG) retrieves responses for a selected 

period, smart execution is used to determine the period from when you last ran the 

collection or using a start date and end date. 

9. These responses are then imported into the Response database (RS_DB) ready for 

analysis by your FastStats system. 

Schematic showing scheduling performed in FastStats or PeopleStage. 

 

The key difference in this process is messages are sent from MAPP automatically, 

allowing full control of the campaign scheduling from within the Apteco Marketing 

Suite.  

Note: 

For th2Be message to send automatica8Blly, you need to create a Template in MAPP. 
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3 Apteco System Configuration 

 Creating the Response Database 
You will need to create a response database to receive your responses from the ESP.   

Note: 

If PeopleStage has been installed this step can be omitted as the RS_<SystemName> 

database will have been created. Continue from Chapter 3.3 

1. Open the FastStats Configurator. 

Tip: 

Search for Fast in the Start Menu  

 

2. Select Database Management. 

 

3. Select the Database Creation Wizard option and click Start Wizard. 

 

 

 

 

 

A PeopleStage 
system will 
already have 
this database  
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4. Enter the name of the Database Server where you wish to store the response 

database, click Test Connection 

 

Note: 

The Database Server name can be found by launching SSMS and finding the SQL 

Instance for your FastStats system, for example TDWIN10B\SQLExpress.   

 

5. Enter a System name (for example Holidays) and your secure password.  
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6. Select the Email Response check box, then click Next. 

 

Note: 

The Response Database may already exist, see the Notes column if it does you do not 

need to complete this process, click X to exit the installer. 

7. Click Next o9Bn the Review actions step. 
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8. Click Run Scripts. 

 

9. Click Finish. 
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 Linking the Response Database to the FastStats 
Service 
You need link the response database to the FastStats service. 

Note: 

If PeopleStage has been installed this step can be omitted as the RS_<SystemName> 

database will have been created. Continue from Chapter 3.3 

1. Open the FastStats Configurator 

2. Select FastStats Services 

 

3. Select the FastStats Service for the system to link to the response database, click 

Properties 
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4. Select the system tab you want to link the response database, select Email 

Broadcasting from the list on the left and then enter the database connection 

string to your response database. 

 

5. Click Test Connection, click OK to close the dialogue box 

 

6. Select Save from the File menu 

General Considerations: 

For broadcasts to work correctly you will need to ensure that the FastStats server has 

access to the relevant MAPP servers through port 80 

Note: 

A restart of the FastStats service is required to pick up the chang10Bes to the 

configuration, click Restart in the Managed Services dialogue box. 
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 Installing the Email Response Gatherer 
You can find the FastStats Email Response Gatherer installer in the 

DigitalIntegration.zip, extract the zip file to your designated PC where you want the 

email response web gatherer to run.  

Digital Integration.zip available from: 

https://www.apteco.com/portal/software-releases 

Note: 

The FastStats Email Response Gatherer application can run on any PC in your system. 

 Open the EmailResponseGatherer64Setup.msi from the DigitalIntegration\ 

EmailResponseGatherer folder. 

1. Click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.apteco.com/portal/software-releases
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2. Select the check box to accept the terms and click Next 

 

3. Click Change if you wish to install the Email Response Gatherer application in a 

different location then click Next 

 

Note: 

The default directory for this is C:\Program Files\Apteco\FastStats Email Response 

Gatherer x64 but may be different, we recommended that you install this in your 

FastStats application files directory on the FastStats Application Server. 
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4. Click Install to start the installation 

 

5. Once the installation has completed, click Finish 
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 Creating the Response Gatherer Folders 
You will need to create folders to store the files to use with the Response Gatherer; 

these will include the following types of files. 

Table 1 – Files Associated with the Response Gatherer 

Type of file Description 

Batch (.bat)  Contains the information for applications 
like Task Scheduler or command-line 
programs to run the Response Gatherer on a 
schedule 

XML (.xml) Contains the connection and communication 
parameters used to connect to the 
broadcaster 

Text files (.txt) The Response Gatherer will generate two log 
files each time it runs, an Event log with the 
times each event occurred, and a Details log 
with a step by step log of the digital 
response batch process with the broadcaster 

 

Note: 

You can create the directories in any user-defined location and use your own choice of 

name; you must refer to the directories in the batch file. 

A typical example folder structure inside the existing FastStats directory. 

 

Important: 

The bulk insert directory must be accessible from the SQL server and th12Be user running 

the SQL Server Service must have read permissions to it. 
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 Creating the Configuration File 
You will need to create an XML file containing the configuration settings to use with the 

Email Response Gatherer; the XML file is specified in an argument when you run the 

EmailResponseGatherer.exe 

Note: 

You can use the Response Gatherer with multiple integrations by using an XML and 

matching batch file for each integration. 

1. Browse to the directory where you installed the Email Response Gatherer and open 

the EmailResponseConfig.exe, enter your Connection String and click Test 

2. Select [Comments] from the Broadcaster drop-down list 

3. Enter the FTP Username and Password to use with the MAPP API 

4. Use Add to add all the required parameters for the Broadcaster 

5. Use the File menu to save the XML file to the batch and XML file folder 

 

Note: 

The Email Response Config application displays a warning message about required 

parameters until you have included them all.  
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Table 2 – EmailResponseConfig Parameters 

Dialogue Item Settings to use 

Connection String (Required) The connection string to the response 
database for your system 

Timeout (secs) The timeout (in seconds) for the connection 
and query steps, the default is 1200 seconds 

Bulk insert folder (Required) The location to store the results to optimise 
the processing of campaigns that generate 
large volumes of data, SQL Server can BULK 
COLLECT from this location  

PeopleStage Connection String Used for certain broadcasters, to retrieve 
metadata from the PeopleStage database 
Not applicable with MAPP 

See Appendix A Email Response Gatherer Parameters for a full list of available 

parameters to use with the Email Response Gatherer. 

Email Response Config dialogue with REQUIRED FIELDS completed 

 

See Appendix B Email Response Gatherer Parameters for a full list of available 

parameters to use with the Email Response Gatherer. 

Username and Password - The username and password relates to the ftp access and 

will replace the {USERNAME} and {PASSWORD} placeholders in the FTPURL. 
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3.5.1 Response Queue Mechanism 

Setting the USERESPONSEQUEUE parameter to true enables the Response Queue 

mechanism. 

Generally, we recommend scheduling the response queue mechanism to run every 10 

minutes in order to get the very latest responses. 

We also recommend configuring a response gatherer with USERESPONSEQUEUE set to 

false to run each day before the build to ensure that you have a consistent view. 

Note: 

If you are using the response queue, you need to specify the URL (must be at least v13) 

URL=https://cook.shortest-route.com/apteco-demo/api/rest/v13 

Your username and password will need to be the api credentials that have been setup 

  Scheduling the Response Gatherer 
You need to set FERG to run on a scheduled basis, provide it with the broadcaster’s 

communication details (in a .xml configuration file) and the location to output the Log 

files; this example uses Windows Task Scheduler howe27Bver you can use any similar 

application or create Command Line (.cmd) files manually.  

Creating the Batch Files 

The batch files provide the Response Gatherer with the Log file directory and the name 

of the XML file to use. 

Create or modify the batch file using Notepad++ or similar text editor, 28Bsee appendix B 

for an example file, save the file to the batch and xml file directory. 

Using Task Scheduler 

Using the Windows Task Scheduler, you can create multiple Tasks to run the Response 

Gatherer on a timed basis. 

1. Open Windows Task Scheduler 

Tip 

Search for Task in the Start Menu 

 

The Windows Task Scheduler opens 
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2. Select Create Basic Task 

 

Tip: 

You can create folders to organise your tasks 

3. Create a Basic Task step 

a. Give your task a Name and Description 

 

4. Task Trigger step 

a. Select the Trigger interval 

 

b. Enter the Start Date and Time or relevant sub-step details 
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5. Action step 

a. Select Start a program and click Next 

 

6. Start a Program Step 

a. Click Browse then navigate to the folder containing your batch files, select 

the file to use and click Open 

b. Optional: Provide the name of the XML configuration file in the Add 

arguments box, click Next  

Note: The XML file is typically included in the batch file. 

 

7. Summary step – Click Finish 
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4 FastStats Broadcasting & Responses 

Notes: 

You must log in as an administrator to perform the following task. 

The Email Broadcasting Wizard is required for FastStats use only. 

 Enable Email Broadcasting 
You must enable the Email Broadcasting wizard plugin. 

1. Open the FastStats Configurator 

2. Select Web Service 

 

3. Click OK on the Web Service Chooser dialogue box 

 

4. Click Client Configuration 
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5. Select the Discoverer client associated with your system and click Edit 

 

6. On the Plugins tab ensure th 15Be Apteco.Discoverer.Plugins.EmailBroadcasting check 

box is selected then click OK 
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 Configuration in FastStats 
1. Open Apteco FastStats, select the Users explorer, right-click on the Global node 

then navigate to Modify > Plugin Configurations 

 

2. Expand the Wizard node then clear the Inherit check box for Email Broadcasting 

(User Defined Fields) and then click on the Edit button. 

 

Clear 
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3. Click Add to add a new template 

 

4. Enter a Name, select the appropriate Resolve Table from the drop-down and select  

Teradata from the Broadcaster drop-down. 

 

Note: 

Scroll to enter the Known Parameters information, * indicates a required parameter. 

Complete the template parameters form with the required settings for your MAPP 

account. 
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Table 3 – Edit Template Known Parameters Settings 

Parameter Settings to use 

URL https://[securewebdomain]/api/soap/v7/ 
Replace [securewebdomain] with the domain 
provided by MAPP, you need v13 or higher to use the 
Response Queue mechanism  

Use Dated List (optional) Default = True (check-box selected) 
Dated List Format (optional) yyyyMMdd-HHmmss 
FTP URL e.g ftp.apteco.com/foldername 
FTP Username Your FTP username 
FTP Password Your FTP password 
  
SFTP Private Key (optional) blank by default (only relevant if using a private key 

on the FTP site) 
Host sslh.teradatadmc.com 
Urn Field Name Person URN 
FTP Protocol sftp 
Send Id Field Name (optional) Creates a Member Attribute of the same name on the 

group that holds a unique reference to the upload 
Segment Field (optional) This will create a Member Attribute of the same name 

on the group that holds the dated version of the list 
name.   

Import Automatic Id Automation id of the Process Control XML Trigger 
Automation setup on your account. 

Auto Broadcast Default = True (check-box selected) 
System Field Names Identifier|Email|MobileNumber|FirstName|LastName 

(blank by default, enter a list of pipe delimited fields) 
Message Retrieval Period 1M 
Named Attributes BusinessName|City 

(blank by default, enter a list of pipe delimited fields) 
Group Template Attribute Group Template Attribute name in Mapp 
Group List Attribute Group List Attribute name in MApp 
Encoding UTF8 
  

 

Note:  

*These settings will be specific to your MAPP account.  

See Appendix B for all the available parameters  

Note:  

You will need to exit out of FastStats and log in again for these changes to take effect. 
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 Adding a Predefined Broadcasting Field Set 
As MAPP is a predefined digital integrator, you need to define a predefined output 

sequence which will identify the variables that will be uploaded in your list. 

Note:  

You must set up a message in MAPP before performing this step see Appendix A 

Configuring MAPP. 

1. From FastStats select Tools > Administrative Functions >Setup Broadcasting 

Fields 

 

2. The Setup Broadcasting Fields dialogue opens, Click Add New Broadcasting 

Field 
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3. Enter the Set Name to match the Template Name in MAPP 

 

Note: 

Use the Set Name to associate each new output field with a Set 

1. Click Add New Broadcasting Field and complete each Update Broadcasting 

Field dialogue until the list of broadcasting fields is complete 

Table 4 – Predefined Broadcaster Output Sequence Fields 

Parameter Settings to use 

Set Name Template name in MAPP 
Variable Select the Variable that you wish to include in your 

sequence 
Header Use the Header field to give the variable a name so that 

it matches the field name in your MAPP account 
Output Style Select to either the Code or Description from the 

Output Style drop-down. 
Output 
Unclassified as 
Spaces 

Select this check-box if you wish unclassified values to 
appear as spaces or if this variable is an email or SMS 
field 

Email Field Select this check-box when defining the Email field. 

SMS Field Select this check-box when defining the SMS field. 
Sequence Id The Sequence ID allows you to order your variables in 

the set. 
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4. At least one of the fields must be an Email Address 

 

Note: 

You can create multiple templates and sets and then reference these separately 

from your email broadcasts. 
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 Checking your configuration 
To use the Email Broadcasting Wizard, select the Email Broadcasting icon from the 

Output Wizards section on the Wizards panel. This will send a test email. 

1. Select the Upload Template, if you have multiple upload sequences configured 

select the template from the drop down list and click Next. Otherwise, you will 

be taken straight to the Selection step 

 

2. Drag a selection from FastStats with the contact/s you wish to send a test 

message to 

 

Tip: (This is How to Check Your Channel Settings) 

Email Broadcasting Details Form 

1. Enter the Username 

2. Enter the Password 

3. Click the List Name retrieve button 

4. After a short while you should be able to use the drop-down list to see the 

available lists from MAPP 

 

If you do not see a list do not proceed, something is wrong in a previous configuration. 
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3. Complete the Email Broadcasting Details form then click Finish 

 

Table 4 – EmailResponseGatherer.exe.config Settings 

Option Settings to use 

Username  A username from your MAPP account 
 

Password The password for your MAPP account 
List Name drop-down Click on the List Name retrieve button and select a 

list from the drop-down (this appends any new 
records to the list) or enter a new List Name 

Message Name Click on the Message Name retrieve button and 
select one from the drop-down or leave it blank if 
you only want to upload your list 

A copy of the list will be 
saved to the directory 
below 

Browse to the location where you wish to save a 
copy of the list 

Email Address Enter an Email Address, FastStats will use this to 
notify you once the list has been processed and 
then click Next 

4. If you entered a message name, a Broadcast Warning message displays meaning 

this will send a message to your target audience 

Click Yes to commit this action 
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5. Once the list has been uploaded (and if applicable the message delivery has 

been scheduled), the wizard will complete.  Click Finish 18Bto close the wizard. 

 

 

6. The recipients in your selection should receive an email using the template 

from MAPP 
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 Email Responses Wizard 
When your emails have been sent out you can start analysing the responses from your 

target audience. 

1. Open the Email Responses wizard 

2. Enter the name of the message that you used in the Email Broadcasting wizard 

and click Next 

 

3. As the Email Response Gatherer starts collecting information from MAPP, you 

will see how customers are interacting with your broadcast. If you want to 

analyse this information further, click on Create a virtual variable from this 

information and then click Next 
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4. Drag the Email variable that you used in the Email Broadcasting wizard onto 

the drop box and click Next 

 

 

5. Locate the folder where you wish to store the virtual variable and click Next 
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6. Enter any notes that will be stored along with the virtual variable and click Next 

 

7. Enter a Description for the virtual variable or drag an existing virtual variable 

onto the drop box if you wish to overwrite it. Modify the Security Att19Bributes if 

applicable and then click Next 
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8. Click OK 

 

9. Click Finish 
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5 PeopleStage Broadcasting & Responses 

  Defining the Broadcast Channel in 
PeopleStage 
To use MAPP with PeopleStage, you must set up a channel that defines the settings and 

parameters and any fields that you always want to send to MAPP. 

1. Open PeopleStage, select File > Administration > Channel Editor.  Click Add 

Email Channel through the context menu within a folder 

 

2. Enter a name in Channel Name 

 

Note: 

(Optional) Select Yes from the Allow In Transactional Output (you need to be careful 

if you select this option, as it means we can send multiple emails to the same email 

address) 
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3. Define Output Settings for MAPP 

 

Table 5 –PeopleStage Output Settings 

Field Settings 

Broadcaster Select Teradata from the drop-down 
Username Enter your API username 
Password Enter your API password 
Variable Name Select Email Address from the drop-down 
Variable Description Override Enter the description, for example, “Email” 

Note: This must correspond to the e-mail field 
within MAPP 

Upload but don’t broadcast (Optional) – Select this check box to upload the list 
only without initiating a broadcast 

Reply email Address The email address that will receive notifications 
when the channel is used, i.e. list uploaded / 
broadcast. 
Note: This is not the reply email address that will be 
used for the email send. 

Number of Retries The number of times to retry on failure of the 
channel.  It is recommended (for Broadcast 
Channels) to leave this at 0.  The Delivery Agent also 
has a retry value, so setting this to > 0 can result in 
multiple retries and may cause undesirable results 

Response File Key Type The key field to match responses to sends.  Varies 
from broadcaster to broadcaster due to the fields 
they return in the response file.  Should be set to 
Communication Key for MAPP. 

Message Content Type Only Dynmark has the ability to use PeopleStage 
templates so this will always be Broadcaster 
Template.  This is where the creative comes from. 
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4. Complete the File Settings 

 

Note: 

The default Encoding is Windows-1252 if you change use the same setting on the 

Parameter Settings tab. Change to utf-8 
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5. The ESP Parameter Settings tab is blank by default, select parameters from the 

drop-down and click Add to complete the form, there are no required 

parameters, these are optional depending on your requirements. 

You will be able to get these from MAPP or contact your Partner or Apteco 

 

Table 6 –Example PeopleStage Parameter Settings 

Parameter Name Reqd Description 

URL Y End point of the API for your account. 
FTP URL Y [address@domain.com] Your own FTP folder 
FTP Username Y Your FTP username 
FTP Password Y Your FTP password 
Urn Field Name Y Person URN 
FTP Protocol Y sftp 
Import Automatic Id Y Automation id of the Process Control XML 

Trigger Automation setup on your account. 
System Field Names Y Identifier|Email|MobileNumber|FirstName|

LastName 
(blank by default, enter a list of pipe 
delimited fields) 

Message Retrieval Period Y 1M 
Named Attributes Y BusinessName|City 

(blank by default, enter a list of pipe 
delimited fields) 

Encoding Y UTF8 
   

See Appendix B for all the available parameters 
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6. Add any additional variables on the Additional Variables tab 

 

7. Click Save & Close 
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 20BBroadcasting in PeopleStage 
You can now test your channel at any Delivery Stage 

1. You can drag your new MAPP channel from the Library to your Delivery step 

 

2. You can select from the available messages in MAPP from the Message Name 

drop-down or use PeopleStage’s functionality to dynamically select a message, 

to use a different language for example. 

 

3. You can use the same List Name as the Message Name or define a custom one 

Selecting the Requires Manual Approval check box gives the option to view a sample 

list before processing 

Note: (This is How to Check Your Channel Settings) 

An error message when clicking the  “Refresh Channel Message Names” button 

may mean that the Channel settings are incorrect, check the PeopleStage Channel 

Settings are correct then in your delivery step test you can collect message names. 
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Appendix A: MAPP Configuration 

MAPP stores all your contacts using the lists you upload into Groups. Custom 

data fields can be created to hold specific transactional data, contact your 

MAPP Account Manager or the MAPP support desk for help setting up these 

fields. 

1. Login to your MAPP account to access the web-based control panel 

The endpoint for the Mapp Digital api can be unique per client, the login will be 

unique also and provided by MAPP in the form 

https://sslh.domainame.com/accountname/ 

 

Note:  

This section uses a specific example to show the areas that need to be setup in 

MAPP, your setup will likely be different, please contact MAPP support or the MAPP 

help for additional information. 

29BSetting up an FTP location 

Note: 

You will need your own FTP location with username and password to create FTP 

Account Credentials in MAPP.  

Create a directory in the root of your ftp site called XmlJob for the Apteco Marketing 

Suite upload the Mapp Package files that control the audience 

1. From the Administration area > Permissions  > Credentals section -  Click 

Create to create permission entry: 

a. Name = domain e.g. ftp.apteco.com 

b. Description = enter a description (optional0 

c. Type = FTP Account  
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30BCreate an Overall Groups Configuration Template 

Note: 

Groups are Lists is FastStats and PeopleStage 

1. From the Groups area > Configuration Template - Click Create to create the 

overall configuration template 

 

2. Enter a Name and Owner, the name is used to associate subsequent settings 

 

3. Setup the Reply Handling page 

 

4. Use the defaults for the Deactivated and Notifications pages and select the 

appropriate Tracking & Links settings 

 

 



MAPP Integrations Guide Appendix A 
D067T3X003 - March 2020 

 

 44 

5. Use the defaults for the Sendout Options settings except for setting 

Transactional Messages to On 

 

6. Click Save 

31BAdditional Group Settings 

1. Create a New Group 

 

2. Set the Transactional Messages value to On in Sendout Options 
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When integrating with PeopleStage, an ExternalTransactionId needs to be setup on your 

account that includes the SendId field and the Communication Key field separated by 

a pipe (|) character.  This is then returned as part of your response notifications and 

allows FastStats to cross reference the broadcast with the response. 

Note: 

The ExternalTransactionId is recorded at the point the campaign is sent from Mapp 

Digital.  Therefore, if a campaign is set to upload only and multiple uploads are carried 

out between sends, there is the potential for a user's SendId and Communication Key 

to be overwritten with new values before the first intended send goes out. 

Careful consideration needs to be taken over subscription management.  Currently, we 

can only import users into groups and cannot create Mapp Digital selections via the 

api.  Some clients will use selections to manage their un-subscribes which may mean 

the upload only method has to be used via the FastStats integration.  Also note that 

when overwriting a group, un-subscribes are not honoured so may well be added to 

the group again via FastStats. 

3. Set the Pattern for the TMID to “SendId|CommunicationId” 

<%${user.MemberAttribute['SendId']}%>|<%${user.MemberAttribute['Communication 

Key']}%> 

 

Note: 

New Groups (Lists) can be created from a default template.  This template is identified 

by using an attribute called AptecoControlAttribute which has a default value of 

ListTemplate.   

The value can be customised by modifying the GROUPTEMPLATEATTRIBUTE parameter.  

The template should be setup with the standard fields required for all your subsequent 

groups.  Without this template, you will not be able to create new Groups (Lists) via the 

integration. 

4. Once complete click on the three dots to the right of the Edit icon and select 

Group Attributes 
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5. Click New Group Attribute 

 

6. Set the Name to “AptecoControlAttribute” and Value to “ListTemplate” 

 

 

32BDefining Exports 

You need to define an export to send the FTP location 

1. From the Administration area > Exports  section -  Click CREATE 

2. Set the Type to Raw Data Export and Enter a Name to use 

 

Note: 

Ensure that you define the relative Time Frame as something that gets the latest data 

that you require.  The Time Frame for Export at the bottom gives a good indication 

that you are not going to be missing data. 
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3. Set the Parameters page 

 

4. Select the Parameters to include. You can add more information if required, 

and record these in the ResponseDetails, the image below shows the minimum 

recommended fields 
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5. Select the Event Data fields, ensure you select: 

• Email 

• Mobile Number 

• Identifier 

• Message Name 

• Timestamp 

• Event Type 

• Transaction Message ID 

 

6. Set the Export Configurations page, using your FTP Location 
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33BCreate Two Automations 

Process Control XML 

In order to automatically import contacts into your groups via the integration, a 

Process Control XML Trigger Automation needs to be setup that points to your sftp 

location.  The Id of this automation should then be used as the value of the 

ImportAutomationId parameter. 

1. From the Automations area > Time-based - Click Create 

 

2. Enter a Name for the automation select Process Control XML from the Job type 

drop-down 

3. Enter the information for the required fields 

• System Name =  

• File Location = Your FTP domain 

• Source File = *.zip 

• Encoding = UTF-8 

• File is Zipped = Yes 

• Backup File Location =  

4. Set the Schedule Automations settings then click SAVE & CLOSE 
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Generate Export 

1. From the Automations area > Time-based - Click Create 

 

2. Enter a Name for the automation select Generate Export from the Job type 

drop-down, select the previously configured Export from the Export drop-down 

3.  Set the Schedule Automations settings then click SAVE & CLOSE 
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34BSetting up a Message in MAPP 

1. From the navigation menu select Messages  > Draft Messages 

2. Click Create 

3. Enter a Message Name and complete the form. click Create> 

4. Enter an Email Subject Line and add your personalisation then click Prepare 

Sendout 

5. On the Configuration page Select the Group (List) to associate with, Message 

Transport “immediately” to allow FastStats or PeopleStage to control the 

Scehdule then click Check Message 

Parameters can be added in the HTML Code  section 

<%${user['FirstName']}%> 

<%${user.CustomAttribute['Communication Key']}%> 

<%${user.CustomAttribute['Run Number']}%> 

 

35BServer Considerations 

The endpoint for the Mapp Digital api can be unique per client.  The standard uri takes 

the format https://sslh.domainname.com/<accountname>/api/soap/v7/.  Outbound 

access for the FastStats service and/or the Email Response Gatherer will be required to 

this destination.   

Note: 

All communication is done over a secure channel so access over port 443 is required. 
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Appendix B: 39BAPI Parameters 

The following data is inserted into the FastStats Email Response Table as part of the predefined 

configuration, you can optionally override the settings by adding them in the FastStats Email Response 

Configurator 

Table 9 – Email Response Gatherer Parameters 

 Reqd Default MAPP extract file column 
*FTPURL Y true This should refer to the ftp location where 

your Mapp Digital download will be 
generated.  This should be in the format 
<ftpprotocol>://{USERNAME}:{PASSWORD
}@<ftpurl> replacing the bold entries as 
appropriate. 

UESRESPONSEQUEUE Y false Setting this value to true will enable the 
response queue mechanism 

Note: 
If you are using the response queue, you need to specify the URL (must be at least v13) 
URL=https://cook.shortest-route.com/apteco-demo/api/rest/v13 
Your username and password will need to be the api credentials that have been setup 
LookupBroadcastIdsOnTheFly   The default value of false, will force the 

Email Response Gatherer to download a 
full list of Broadcast Ids from all the 
previous broadcasts in the response 
database.  This can then be used to 
quickly match responses to broadcasts.  If 
set to true, the Broadcast Ids will be 
fetched and cached as and when required. 

OnlyProcessRecordsWithBroadcas
tId 

  Setting this to true will force the Email 
Response Gatherer to only download 
responses to messages that have 
originated from FastStats.  The default 
option is false, all responses will be 
downloaded. 

LOCALTIMEZONE N Local Specifes the time zone to store your dates 
in.  This allows you to write responses in 
your current time zone. 

SERVERTIMEZONE N GMT Standard 
Time 

Specify the time zone that your 
broadcaster uses when returning data.  
This allows you to write responses in your 
current time zone. 
This value is pre configured for each 
broadcaster, options are Local, Central 
Standard Time, W. European Standard 
Time, UTC, GMT Standard Time, see the 
link below. 

CLICKDATECOLUMNNAME Y click.Timestamp This should refer to the column in Mapp 
Digital that holds the date representing 
the date the link was clicked.  This value 
will get inserted into the ClickDate field in 
the Response table. 

URNCOLUMNNAME Y user.Identifier This should refer to the colulmn in Mapp 
Digital that holds the FastStats URN.  This 
will only be available if it has been 
originally uploaded from FastStats.  The 
value will get inserted into the Urn field in 
the Response table. 

MESSAGENAMECOLUMNNAME Y message.Name The message name is not returned in the 
Mapp Digital extract file but a reference is.  
Therefore, this should typically be left as 
the default value. 

DELIVERYDATECOLUMNNAME Y record.sentToMTA.
Timestamp 

This should refer to the column in Mapp 
Digital that holds the date representing 



MAPP Integrations Guide Appendix B 
D067T3X003 - March 2020 

 

 54 

the delivery date.  This value will get 
inserted into the DeliveryDate field in the 
Response table. 

EMAILCOLUMNNAME Y user.Email This should refer to the column in Mapp 
Digital that holds the email address.  The 
value will get inserted into the Email field 
in the Response table. 

FILEPATTERN Y “export” This allows you to filter your responses to 
specific types when reading files from the 
ftp site 

DATEOFFSET Y 0 Specify a value in hours to offset any date 
values received.  This allows you to write 
responses in your current time zone. 

TYPECOLUMNNAME Y record.Type This should refer to the column in Mapp 
Digital that holds the response type.  This 
value will usually get converted and then 
inserted into the MessageType field in the 
Response table. 

CLICKURLCOLUMNNAME Y click.Link.Url This should refer to the column in Mapp 
Digital that holds the name of the url that 
was clicked.  This value will get inserted 
into the ClickUrl field in the Response 
table. 

EVENTTRIGGEREDDATECOLUMNNAME Y record.Timestamp This should refer to the column in Mapp 
Digital that holds the date representing 
the date the response occured.  This value 
will get inserted into the 
EventTriggeredDate field in the Response 
table. 

MAXRETRIES Y 1000 This value refers to the number of times 
the Email Response Gatherer will check to 
see if the extract file exists on the ftp site. 

TreatTypeAsAdditionalField Y False Setting this to true will force the raw 
response type received from Mapp Digital 
to be written to the ResponseDetails table 
before any conversion is carried out. 

AdditionalFields Y e.g. 
group.Id|group.Na
me|record.External
TransactionId 

Allows you to specify a pipe (|) delimited 
list of the additional fields you wish to 
include in the Response Details table.  This 
only acts as a filter, i.e. you can only 
specify fields that are included in the 
extract file. 

    
EXECUTIONTAG N  When using Smart Execution, this can be 

used to identify separate accounts when 
using the same broadcaster. 

EXECUTIONBUFFER N 0 Adds a buffer in minutes to the start of the 
response window.  Use this to create an 
overlap to allow for delayed response 
notifications. 

 

Note:  

*These settings are specific to each MAPP account. 
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Table 10 – Email Broadcasting Parameters 

Parameter Required 

Y/N 

Default Description 

URL Y e.g. 

https://[securewebdo

main]/api/soap/v7/ 

This should refer to the end point of 

api for your account. 

Use Dated List N True Default = True (check-box selected) 

Dated List Format N yyyyMMdd-HHmmss If UseDatedList is set to true, this 
parameter will allow you to specify a 
date format string for the date and 
time stamp. 

FTP URL Y  [address@domain.com] Your own 
FTP folder 

FTP Username Y  Your FTP usernename 
FTP Password Y  Your FTP password 
SFTP Private Key N  blank by default (only relevant if 

using a private key on the FTP site) 
Host N  sslh.teradatadmc.com 
Urn Field Name Y Person URN Enter the name of the field you wish to 

use as the Identifier on the Mapp 
Digital group.  This will be returned as 
the Urn in the response process. 

FTP Protocol Y sftp At the moment, Mapp Digital only 
supports sftp sites. 

Send Id Field Name N SendId This will create a Member Attribute of 
the same name on the group that 
holds a unique reference to the 
upload.  This is then returned as part of 
the response process to allow FastStats 
to cross reference the broadcast with 
the response. 

Segment Field N Segment This will create a Member Attribute of 
the same name on the group that 
holds the dated version of the list 
name.  This could then be used to 
segment users within the group via a 
Mapp Digital selection. 

Import Automatic Id Y e.g. 1234567 If you wish to automatically import 
users into groups, enter the 
automation id of the Process Control 
XML Trigger Automation setup on your 
account. 

Auto Broadcast N True Default = True (check-box selected) 
System Field Names Y Identifier|Email|Mo

bileNumber|FirstNa
me|LastName 
 

*See information below (blank by 
default, enter a list of pipe 
delimited fields) 

Message Retrieval Period Y  1M 
Named Attributes Y BusinessName|City 

 
*See information below (blank by 
default, enter a list of pipe 
delimited fields) 

Encoding Y  UTF8 
 

*A Mapp Digital contact has fixed Standard attributes (like First Name, Last Name, etc) 

and Custom attributes that can be created on an ad-hoc basis (providing you have the 

correct permissions to do so). 

Additionally, a Mapp Digital group has Member attributes that can also be created on 

an ad-hoc basis (again, given the correct permissions). 
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If you look at a contact within a group, you will see the combination of attributes 

available. 

Contact Management > Edit Contact Profile 

 

Any Custom attributes should be pre-defined via the Mapp Digital DMC whereas 

Member attributes can be created via the API. 

*System Field Names 

If you need to upload to Standard attributes, these need to be listed as System Field 

Names within the Parameter Settings. 

*Named Attibutes 

If you need to upload to Custom attributes, these need to be listed as Named 

Attributes within the Parameter Settings. 

Again, any additional variables or content fields should then use the exact same 

descriptions to ensure they are treated as Custom attributes. 

Any variables or content fields that are uploaded that do not match either the 

SystemFieldNames or NamedAttributes will be uploaded as Member attributes. 
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36BPeopleStage Content 

Within a PeopleStage content step you can add further fields that will either match the 

SystemFieldNames, NamedAttributes or be uploaded as Member attributes. 

 

37BTracking Fields 

When the PeopleStage campaign runs, a date and time stamped version of the list name 

will be inserted into a Member attribute called Segment (this can be changed by 

populating the Segment Field parameter in the channel editor).  This can then be used 

to segment contacts via Mapp Digital selections within the DMC. 

As well as this, a unique SendId will be generated per broadcast and this will be 

inserted into a Member attribute called SendId.  This allows a specific instance of a 

broadcast to be tracked via the FastStats Email Response Gatherer. 

Each contact that is uploaded will also get a unique Communication Key that will be 

inserted into a Member attribute called Communication Key.  This will also be returned 

to the FastStats Email Response Gatherer and will enable response notification records 

to be linked back to the communication table in the PeopleStage database. 

Note. 

These values are overwritten each time the contact record is uploaded.  Therefore, if 

multiple uploads are carried out between sends, there is the potential for a user's 

SendId and Communication Key to be overwritten with new values before the first 

intended send goes out. 
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Appendix C: 40BExample Batch File 

Example batch file to use with FERG and scheduling 

@echo off 

REM**************************************************************************** 

REM File Name: TeradataBatchFile.bat  

REM Date: 30/01/2018 

REM ToDo: 

REM Define the drive and folders to output the log files 

REM Set FERG to define the location of the EmailResponseGatherer64.exe 

REM Set LOGFILE to the folder where the event logs are stored 

REM Set LOGFILEDETAILS to the folder where detail logs are stored 

REM Define the XML configuration file to use 

REM *************************************************************************** 

C: 

cd C:\FastStats\FERG 

REM *************************************************************************** 

REM Change the drive letter to match the drive where your FastStats directory has been setup 

REM *************************************************************************** 

cls 

SET FERG="%ProgramFiles%\Apteco\FastStats Email Response Gatherer x64\EmailResponseGatherer64.exe" 

SET LOGFILE="Logs\Teradata.txt" 

SET LOGFILEDETAILS="Logs\Teradata Details.txt" 

echo. >> %LOGFILE% 

echo. >> %LOGFILEDETAILS% 

echo %date% %time% - Starting FastStats Teradata Response Download >> %LOGFILE% 

echo %date% %time% - Starting FastStats Teradata Response Download >> %LOGFILEDETAILS% 

echo. >> %LOGFILE% 

>> %LOGFILEDETAILS% 

echo. 

%FERG% Teradata.xml >> %LOGFILEDETAILS% 

IF ERRORLEVEL 9003 goto FailedException 

IF ERRORLEVEL 9002 goto FailedLogout 

IF ERRORLEVEL 9001 goto FailedDownload 

IF ERRORLEVEL 9000 goto FailedLogin 
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:OK 

echo %date% %time% - FastStats Gathered Teradata Responses OK >> %LOGFILE% 

goto Complete 

 

:FailedLogin 

echo %date% %time% - FastStats Gatherer Failed - Login Failed to Teradata >> %LOGFILE% 

goto Complete 

 

:FailedDownload 

echo %date% %time% - FastStats Gatherer Failed - Downloading from Teradata >> %LOGFILE% 

goto Complete 

 

:FailedLogout 

echo %date% %time% - FastStats Gatherer Failed - Logging out of Teradata >> %LOGFILE% 

goto Complete 

 

:FailedException 

echo %date% %time% - FastStats Gatherer Failed - API Exception Teradata >> %LOGFILE% 

goto Complete 

 

:Complete 

echo %date% %time% - Completed Response Download >> %LOGFILE% 

End of example text 

To see how to use the batch file see section 3.4 Scheduling the Response Gatherer 

 

 

 

 

 

 

 

 

 

 



MAPP Integrations Guide Appendix D 
D067T3X003 - March 2020 

 

 60 

Appendix D: 41BTroubleshooting 

The following are some common problems that may occur, and procedures for 

resolving them. 

Errors relating to configuring and using FERG 

These errors can occur due to missing files 

Description: Error received when running FERG using a batch file 

Error: Could not read email response configuration file: Could not 
find file 'D:\FastStats\FERG\Teradata.xml'. 

Teradata.xml refers to the filename referenced in this section of the batch file: 

%FERG% Teradata.xml>> %LOGFILEDETAILS% 

In the location: 

“cd C:\FastStats\FERG” in the batch file  

Solution: Ensure the file exists or change the filename in the batch file to match. 
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